PUBLIC NOTICE

FEDERAL COMMUNICATIONS COMMISSION
445 12th STREET, S.W.
WASHINGTON, D.C.  20554

News Media Information: (202) 418-0500
Fax-On-Demand: (202) 418-2830
Internet: http://www.fcc.gov
ftp.fcc.gov

June 29, 2000

DA 00-1460

AUCTION OF A NEW TELEVISION STATION CONSTRUCTION PERMIT, CHANNEL 52 AT BLANCO, TEXAS

11 Qualified Bidders

Report No. AUC-80-C (Auction No. 80)

This Public Notice identifies 11 applicants that have been found qualified to bid in the auction for a new television station construction permit for Channel 52 at Blanco, Texas (“Auction No. 80”), which is scheduled to begin on Wednesday, July 12, 2000. This Public Notice also contains bidding instructions and other important information regarding the auction.

Attachment A lists each of the 11 qualified bidders, their upfront payments, and maximum eligibility in bidding units.

Attachment B lists those applicants that submitted short-form applications (FCC Form 175), but did not qualify to bid in this auction.

Attachment C contains software downloading/installing instructions for participation in the mock auction.

Attachment D provides information on “How to Monitor FCC Auctions Online” and round results file formats for use during the auction.

Attachment E provides information concerning Accessing the FCC Network using Windows 95/98.

In order to participate effectively in the auction, qualified bidders should re-familiarize themselves with the auction rules and other information contained in the Public Notices released
for this auction. The following information provides additional guidance.

**Registration.** Qualified bidders have been automatically registered for the auction. For security reasons, the Commission will confirm registration by two separate mailings of registration materials, both sent to the contact person at the contact address identified in the bidder's FCC Form 175. Each mailing will include confidential bidding codes. The second mailing will also include remote bidding system software, if ordered. Upon receipt of both mailings, each bidder should be in possession of the following information:

- FCC Account Number (as assigned by FCC)
- Bidder Identification Number
- Login ID
- Login Password
- Remote bidding system software and instruction booklet (if purchased)
- FCC Bidder Line Telephone Number

Applicants are solely responsible for ensuring the security of their computer systems, the security of their bidding codes, and that only authorized bidders place bids on their behalf. The FCC assumes no responsibility or liability for these matters.

**WARNING:** Any unauthorized person or entity accessing or tampering with an FCC or other government computer will be prosecuted to the full extent of the law.

Any applicant listed as a qualified bidder in Attachment A to this Public Notice that has not received both registration mailings by noon on Friday, July 7, 2000, must contact the Auctions Hotline directly at (717) 338-2888. It is each applicant's responsibility to ensure that all registration information has been received. Note: The bidding software mailed via Federal Express is not the software used in the mock auction, and is specifically designed to only be used in the actual auction event. The downloadable mock auction software is discussed later in this public notice.

**Bidding Code Replacement.** Lost Login IDs, Login Passwords and Bidder Identification Numbers can be replaced only at the FCC Auction Headquarters, located at 445 12th Street, S.W., Washington, D.C. If replacement is necessary, either an authorized representative or the certifying official (as designated on the applicant's FCC Form 175) must appear in person with two forms of identification, one of which must be a photo identification. The authorized representative should immediately contact the technical support hotline to arrange the replacement of bidding codes.

**Electronic Bidding Software.** Only those qualified bidders that have purchased the Commission's electronic bidding software will be permitted to bid electronically. The software has been updated for Auction No. 80; therefore, software from prior auctions will not work

---

for this auction. For software backup, bidders are advised to duplicate the software for use by its authorized bidders at different locations. However, the FCC Remote Bidding Software will not accept electronic bids from qualified bidders who have not purchased the bidding software.

Bidding Contingency Plan. Bidders should develop comprehensive contingency plans they can implement quickly in case they experience difficulty participating in the auction. While the FCC will correct any problems within Commission-controlled facilities, bidders are solely responsible for anticipating and overcoming problems such as bidder technical failures, local telephone service interruptions, adverse local weather conditions, unavailability of authorized bidders, or loss or breach of confidential security codes.

The FCC Remote Bidding System requires access to a 900 service telephone line. Bidders should verify in advance that the telephone systems they will be using to submit electronic bids permit access to 900 service telephone numbers, and should consult their telephone administrators if they need assistance.

All qualified bidders will be supplied with a telephone number for telephonic bidding in their registration materials. Those choosing not to bid electronically are required to use this telephone number to place bids. Electronic bidders may use this telephone number as an alternate method of bidding in the event they are not able to submit their bids electronically.

Minimum Opening Bids. There will be a minimum opening bid of $420,000 for the construction permit in Auction No. 80, calculated in accordance with the formulas we have previously announced. The minimum opening bid amount is subject to reduction at the discretion of the Commission. Bidders should be aware, however, that the FCC will not entertain requests to lower the minimum opening bid. The agency will exercise its discretion, if at all, independent of any communications from bidders.

Messages and Announcements. The FCC will post pertinent auction information as messages and announcements on the FCC Remote Bidding System and on its Internet site. Bidders should routinely check for messages and announcements each time they enter the Remote Bidding System, and should read this information carefully.

2 See Auction No. 80 Public Notice at 15-16.
**Bidding Schedule.** The bidding schedule for Wednesday, July 12, 2000, will be:

<table>
<thead>
<tr>
<th>Bidding Period</th>
<th>9:00 a.m. - 9:30 a.m. ET</th>
</tr>
</thead>
<tbody>
<tr>
<td>Round Results</td>
<td>9:30 a.m. - 9:45 a.m. ET</td>
</tr>
<tr>
<td>Bidding Period</td>
<td>11:00 a.m. - 11:30 a.m. ET</td>
</tr>
<tr>
<td>Round Results</td>
<td>11:30 a.m. - 11:45 a.m. ET</td>
</tr>
<tr>
<td>Bidding Period</td>
<td>2:00 p.m. - 2:30 p.m. ET</td>
</tr>
<tr>
<td>Round Results</td>
<td>2:30 p.m. - 2:45 p.m. ET</td>
</tr>
<tr>
<td>Bidding Period</td>
<td>4:00 p.m. - 4:30 p.m. ET</td>
</tr>
<tr>
<td>Round Results</td>
<td>4:30 p.m. - 4:45 p.m. ET</td>
</tr>
</tbody>
</table>

The bidding schedule for Thursday, July 13, 2000, and continuing until further notice, will be:

<table>
<thead>
<tr>
<th>Bidding Period</th>
<th>9:00 a.m. - 9:30 a.m. ET</th>
</tr>
</thead>
<tbody>
<tr>
<td>Round Results</td>
<td>9:30 a.m. - 9:45 a.m. ET</td>
</tr>
<tr>
<td>Bidding Period</td>
<td>10:00 a.m. - 10:30 a.m. ET</td>
</tr>
<tr>
<td>Round Results</td>
<td>10:30 a.m. - 10:45 a.m. ET</td>
</tr>
<tr>
<td>Bidding Period</td>
<td>11:00 a.m. - 11:30 a.m. ET</td>
</tr>
<tr>
<td>Round Results</td>
<td>11:30 a.m. - 11:45 a.m. ET</td>
</tr>
<tr>
<td>Bidding Period</td>
<td>2:00 p.m. - 2:30 p.m. ET</td>
</tr>
<tr>
<td>Round Results</td>
<td>2:30 p.m. - 2:45 p.m. ET</td>
</tr>
<tr>
<td>Bidding Period</td>
<td>3:00 p.m. - 3:30 p.m. ET</td>
</tr>
<tr>
<td>Round Results</td>
<td>3:30 p.m. - 3:45 p.m. ET</td>
</tr>
<tr>
<td>Bidding Period</td>
<td>4:00 p.m. - 4:30 p.m. ET</td>
</tr>
<tr>
<td>Round Results</td>
<td>4:30 p.m. - 4:45 p.m. ET</td>
</tr>
</tbody>
</table>

The FCC will set the pace of the auction based upon its monitoring of the bidding and its assessment of the auction's progress. All schedule changes are made by announcement during the course of the auction.

**Bidder Questions during the Auction.** FCC auction officials and technical support staff will be available during the course of the auction to answer questions from authorized bidders. Bidders should identify themselves as a bidder with time sensitive auction questions when calling any number. Help can be obtained through the following telephone numbers:

<table>
<thead>
<tr>
<th>FCC Bidder Line</th>
<th>Use telephonic bid number</th>
</tr>
</thead>
<tbody>
<tr>
<td>(telephonic bidding, auction conduct questions)</td>
<td>supplied in registration mailing</td>
</tr>
</tbody>
</table>
Monitoring Round Results. Attachment D (How to Monitor FCC Auctions On-Line) of this Public Notice provides instructions for reviewing and downloading round results, and other material related to Auction No. 80 released by the Commission during the course of the auction.

Amendments to FCC Form 175s. Applicants are responsible for maintaining the accuracy and completeness of information furnished in their FCC Form 175 and exhibits. See 47 C.F.R § 1.65. It is the staff's position that applicants should amend their applications within ten business days from the occurrence of a reportable change. Filers should make modifications to their FCC Form 175s electronically, and submit a letter briefly summarizing the changes to:

Amy Zoslov  
Chief, Auctions & Industry Analysis Division  
Wireless Telecommunications Bureau  
Federal Communications Commission  
Room 4-A760  
445 12th Street, SW  
Washington, DC 20554

with a courtesy copy to Kenneth Burnley at the same address in Room 4-B524. As described in the Commission's Rules, applicants may make only minor corrections to their FCC Form 175 applications (e.g., mailing address, fax number, authorized bidder). Major modifications (e.g., changing control of the applicant, changing the certifying official) will not be accepted. See 47 C.F.R. § 1.2105(b).

Due Diligence. The winning bidder in the auction for a new construction permit for the new full power television station on Channel 52 at Blanco, Texas, upon submission of its long-form application (FCC Form 301), will have to provide interference protection to qualified Class A television stations. Therefore, potential bidders are encouraged to perform engineering studies to determine the existence of Class A television stations and their effect on the ability to operate a full power television station on Channel 52 at Blanco, Texas.3

Bidders are reminded that they should continue to conduct their own research prior to Auction No. 80 in order to determine the existence of pending proceedings that might affect their decisions regarding participation in the auction.

Mock Auction. The FCC will conduct a mock auction on Monday, July 10, 2000, to allow qualified bidders to familiarize themselves with the electronic bidding software. The mock

---

3 See Auction No. 80 Public Notice at 5. See also Establishment of a Class A Television Service, MM Docket No. 00-10, Report and Order, FCC 00-115 (rel. April 4, 2000) (“Class A Report and Order”).
auction will be open only to qualified bidders. Telephonic bidding will also be available during the mock auction. Qualified bidders wishing to place telephonic bids should use the telephone number supplied in the registration materials for the auction. Pre-registration is not required to participate in the mock auction.

This mock auction will follow the rules governing the actual auction. The mock auction will be identified as Auction No. 74. The software will reflect the construction permit and the associated $420,000 upfront payment, which in turn corresponds to 420,000 bidding units. The mock auction will simulate the start of the auction and all bidders will be required to be active on 100 percent of their bidding units, or risk having a waiver automatically applied. If there are no activity rule waivers available, the bidder’s eligibility will be reduced, eliminating them from the auction.

Electronic bidders participating in the mock auction are advised to review the software manual provided in the second mailing. For installation instructions, please refer to Attachment C of this Public Notice.

The mock auction bidding schedule for Monday, July 10, 2000 will be:

<table>
<thead>
<tr>
<th>Time</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9:00 a.m. - 9:30 a.m. ET</td>
<td>Bidding Period</td>
</tr>
<tr>
<td>9:30 a.m. - 9:45 a.m. ET</td>
<td>Round Results</td>
</tr>
<tr>
<td>11:00 a.m. - 11:30 a.m. ET</td>
<td>Bidding Period</td>
</tr>
<tr>
<td>11:30 a.m. - 11:45 a.m. ET</td>
<td>Round Results</td>
</tr>
<tr>
<td>2:00 p.m. - 2:30 p.m. ET</td>
<td>Bidding Period</td>
</tr>
<tr>
<td>2:30 p.m. - 2:45 p.m. ET</td>
<td>Round Results</td>
</tr>
<tr>
<td>4:00 p.m. - 4:30 p.m. ET</td>
<td>Bidding Period</td>
</tr>
<tr>
<td>4:30 p.m. - 4:45 p.m. ET</td>
<td>Round Results</td>
</tr>
</tbody>
</table>

Eligible Auction No. 80 bidders who wish to participate in the mock auction using electronic bidding must establish a Point-to-Point Protocol (PPP) connection to the FCC Auction Network through either an 800 or a 900 number, as selected through the mock auction software. (The FCC strongly encourages participants to test their ability to connect using the 900 number, in order to identify any potential problems such as a 900-number telephone block. There will be no access charge for the first minute of the 900-number connection time.)

When participants establish the PPP connection and start the Mock Bidding System, they will register for the mock auction by entering their FCC Account Number. The Login name, Login password, and Bidder Identification Number (BINs) will be pre-filled. Note: Pre-filled codes are used for the mock auction only. For the actual auction, bidders must enter the confidential bidding codes supplied in the overnight mailings in order to access the bidding software.

Remote bidding software for the mock auction will be available via the FCC's Internet System by noon on Friday, July 7, 2000. See Attachment C for downloading/installing instructions. This software is specifically designed for this simulation, and is not adaptable to any other FCC spectrum auction. As part of the software, the Commission has established a suggestion box.
and welcomes your comments regarding the software.

OTHER IMPORTANT INFORMATION

Long-Form Applications: Applicants that claim new entrant status should be aware that at the long-form application stage they will be subject to the more extensive reporting requirements contained in the Commission's Part 1 ownership disclosure rule. See 47 C.F.R. § 1.2112(b).

For additional information regarding this Public Notice, please contact Lisa Stover or Bob Reagle, Auctions and Industry Analysis Division, Wireless Telecommunications Bureau, at (717) 338-2888, or Kenneth Burnley, Auctions and Industry Analysis Division, Wireless Telecommunications Bureau, at (202) 418-0660. Questions about software or hardware should be directed to Technical Support at (202) 414-1250.
The following Applicants have been found 'Qualified':

<table>
<thead>
<tr>
<th>FCC Account #</th>
<th>Name</th>
<th>Upfront Payment</th>
<th>Maximum Eligibility (Bid - Units)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000095612</td>
<td>Aaron Communications, L.P.</td>
<td>$420,000.00</td>
<td>420,000</td>
</tr>
<tr>
<td>2000114840</td>
<td>Alliance Trust</td>
<td>$420,000.00</td>
<td>420,000</td>
</tr>
<tr>
<td>2000180847</td>
<td>Blanco Television, LLC</td>
<td>$420,000.00</td>
<td>420,000</td>
</tr>
<tr>
<td>2000153547</td>
<td>Blue Mountain Communications, Inc.</td>
<td>$420,000.00</td>
<td>420,000</td>
</tr>
<tr>
<td>2000112943</td>
<td>ComCorp Broadcasting, Inc.</td>
<td>$420,000.00</td>
<td>420,000</td>
</tr>
<tr>
<td>2000145457</td>
<td>Douglas Johnson</td>
<td>$420,000.00</td>
<td>420,000</td>
</tr>
<tr>
<td>2000112016</td>
<td>Pappas Telecasting of El Paso-Juarez</td>
<td>$420,000.00</td>
<td>420,000</td>
</tr>
<tr>
<td>2000112618</td>
<td>Pegasus Broadcast Television, Inc.</td>
<td>$420,000.00</td>
<td>420,000</td>
</tr>
<tr>
<td>2000154547</td>
<td>Post-Newsweek Stations, Inc.</td>
<td>$420,000.00</td>
<td>420,000</td>
</tr>
<tr>
<td>2000172606</td>
<td>S L Communications, Inc.</td>
<td>$420,000.00</td>
<td>420,000</td>
</tr>
<tr>
<td>2000123701</td>
<td>Univision Television Group, Inc.</td>
<td>$420,000.00</td>
<td>420,000</td>
</tr>
</tbody>
</table>
FCC Channel 52 Blanco, Texas Auction
Non-Qualified Bidders
Auction ID: 80

(Sorted by Applicant)
Date of Report: 6/28/00

<table>
<thead>
<tr>
<th>FCC Account #</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000003451</td>
<td>BK Radio</td>
</tr>
<tr>
<td>2000162115</td>
<td>Channel 52, LLC</td>
</tr>
<tr>
<td>2000182234</td>
<td>Christian Television Media, Inc.</td>
</tr>
<tr>
<td>2000183246</td>
<td>Council Tree Communications, L.L.C.</td>
</tr>
<tr>
<td>2000144046</td>
<td>Elgin FM Limited Partnership</td>
</tr>
<tr>
<td>2000162318</td>
<td>George S. Flinn, Jr.</td>
</tr>
<tr>
<td>2000090206</td>
<td>James L. Oyster</td>
</tr>
<tr>
<td>2000193749</td>
<td>KT Broadcasting, Inc.</td>
</tr>
<tr>
<td>2000143537</td>
<td>Mountain Communications, Inc.</td>
</tr>
<tr>
<td>2000155133</td>
<td>Rodriguez Communications, L.L.C.</td>
</tr>
<tr>
<td>2000120144</td>
<td>Star Broadcasting, Inc.</td>
</tr>
<tr>
<td>2000142650</td>
<td>Venture Technologies Group LLC</td>
</tr>
<tr>
<td>2000131115</td>
<td>WF Broadcasting, LLC</td>
</tr>
</tbody>
</table>
I. ATTACHMENT C

PARTICIPATING IN THE FCC MOCK AUCTION

This attachment describes how to download and install the FCC Mock Bidding Software for qualified bidders who wish to participate in the FCC Mock Auction. It also describes how to monitor the Mock Auction.

Conventions

The instructions in this section use the following typographical conventions:

**bold** Represents objects on the screen that you click with the mouse pointer, including buttons, Internet links, icons, tabs, menu items (e.g., Cancel button, Auctions link, Save option in the File menu).

*italic* Represents field names or areas of a screen (e.g., Location field, Selected Licenses area of a screen).

**bold italic** Represents characters that you must type exactly as they appear in the instructions. For example, if you are instructed to type http://wtbwww01.fcc.gov, you should type all of the characters shown in bold italic exactly as they are printed.

**SMALL CAPS** Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).

*Note:* Throughout these instructions, “enter” means to type the appropriate information and then press the ENTER key.

A. Minimum Hardware and Software Requirements

Qualified bidders who want to participate in the FCC Mock Auction will need, at a minimum, the following hardware and software:

1. Hardware Requirements

- CPU: Intel® Pentium
- RAM: 16 MB (more recommended if you have multiple applications open)
- Hard Disk: 33 MB available disk space
- Modem: 28.8 Kbps Hayes© compatible mode (recommend 56.6 Kbps)
- Monitor: VGA or above
- Mouse or other pointing device
2. Software Requirements

- Microsoft® Windows 95™ or 98™
- FCC Mock Bidding Software, available through the Internet
- Netscape® Communicator™ 4.73 is recommended. However, you can also use Netscape Communicator 4.5, 4.51, 4.61, 4.7, or 4.72 (Internet web browser software).

Note: To download Netscape Communicator 4.73 free of charge, access the Netscape download site at http://home.netscape.com/download/

Note: The FCC Mock Bidding Software has not been tested in a Macintosh, OS/2, or Windows NT™ environment. Therefore, the FCC will not support operating systems other than Microsoft Windows 95 or 98. This includes any other emulated Windows environment.

B. Downloading the FCC Mock Bidding Software

FCC Mock Auction participants must first download the FCC Mock Bidding Software from the Internet. Participants must download the mock80.exe compressed file to install the software.

You may use your Web browser to download the compressed files from wtbwww01.fcc.gov, wtbwww13.fcc.gov, or www.fcc.gov/wtb/auctions/, as described in the following section.

1. Downloading from wtbwww01.fcc.gov or wtbwww13.fcc.gov

1. Connect to your Internet service provider and start your Web browser.
2. Enter the following location: wtbwww01.fcc.gov or wtbwww13.fcc.gov
3. Click Mock
4. Click Programs
5. Download the following file: mock80.exe

2. Downloading from www.fcc.gov/wtb/auctions/

1. Connect to your Internet service provider and start your Web browser.
2. Enter the following location: http://www.fcc.gov/wtb/auctions/
3. In the Auctions section to the right, click Blanco Texas Broadcast (#80) under Future Auctions
4. Click Mock Auction Software
5. Download the following file: mock80.exe

C. Extracting and Installing the FCC Mock Bidding Software

The FCC Mock Bidding Software file is downloaded in a self-extracting, compressed file format. Before installing the FCC Mock Bidding Software for Auction 80, you must uninstall any mock or remote bidding software that was installed on your computer before Auction 80.

After you have downloaded the compressed file for the FCC Mock Bidding Software, you must extract the software from that file. To extract the software, follow these steps:

1. Start Windows Explorer and open the file folder where you downloaded the files.
2. Double-click mock80.exe.
3. Follow the instructions that display on your screen.
4. At the system prompt to reboot, leave Yes (the default) selected and click Finish.

After the FCC Mock Bidding Software has been installed, you will have a new Program group called FCC Remote Bidding System with an Mock 80 Bidding Software option in the drop down list. You will also see two icons on your desktop, labeled Mock 80 Bidding Software and Mock 80 Dial-Up Connection.

D. Connecting To the FCC Network

Before running the FCC Mock Bidding Software, you must connect to the FCC Network via the FCC Auctions 800#. For details about connecting to the FCC Network, refer to the attachment titled Accessing the FCC Network Using Windows 95/98.

E. Starting the Mock Bidding Software

You may start the FCC Mock Bidding Software by double-clicking the Mock 80 Bidding Software icon on your desktop.

Note: Although this is Auction 80 (Blanco, Texas), the auction ID used in the Mock Auction is 74.

F. Tracking the FCC Mock Auction

Mock Auction round results and announcement files will be posted on the FCC Internet in the same location as the auction results. The directory structure for the mock auction will be as follows:

On the primary location, wtbwww01.fcc.gov:

- http://wtbwww01.fcc.gov/Mock/Results/dbf/
• http://wtbwww01.fcc.gov/Mock/Results/mdb/
• http://wtbwww01.fcc.gov/Mock/Results/txt/

For information about the format of these files, refer to the attachment titled *How to Monitor the FCC Auctions On-Line*.

If you cannot access the files at the preceding primary location, you can access the same files at either of the following secondary locations: wtbwww13.fcc.gov or www.fcc.gov/wtb/auctions/.

**G. Uninstalling the FCC Mock Bidding Software**

To uninstall the FCC Mock Bidding Software:

1. Double-click the **Mock 80 Bidding Software Uninstall** icon in the *FCC Remote Bidding System* program group.

   To see the *Programs* list, click the **Start** button, highlight **Programs**, then highlight **FCC Remote Bidding System**.

2. When the *Remove Shared Files?* dialog box appears, click **NO to All**, so you preserve files that are shared with the FCC Remote Bidding Software for Auction 80.

3. When the process has completed, click **OK**.

   **Important:** If the Mock Bidding Software and the Remote Bidding Software for Auction 80 are both installed on your computer, it is very important that you click **NO to All** when the FCC Mock Bidding Software Uninstall program displays the *Remove Shared Files?* dialog box. Otherwise, the uninstall will delete shared program files and you will need to re-install the Remote Bidding Software for Auction 80.

**H. Help**

For technical assistance with installing or using FCC software, contact the FCC Technical Support Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY). The FCC Technical Support Hotline is generally available Monday through Friday from 7 a.m. to 10 p.m. ET, Saturday from 8 a.m. to 7 p.m. ET, and Sunday from 12 p.m. to 6 p.m. ET. *All calls to the FCC Technical Support Hotline are recorded.*
1. ATTACHMENT D

HOW TO MONITOR THE FCC AUCTIONS ON-LINE

The auction announcements and round results for Auction 80 will be accessible through the FCC Wide Area Network, the Internet, and the FCC’s Automated Round Results System. You can check on round results and also read any material released by the Commission during the course of the auction. In the sections that follow, Options 1 and 2 list the information needed to track the auction from your computer; Option 3 lists an alternate method.

Conventions

The instructions in this section use the following typographical conventions:

**bold** Represents objects on the screen that you click with the mouse pointer, including buttons, Internet links, icons, tabs, menu items (e.g., Cancel button, Auctions link, Save option in the File menu).

*italic* Represents field names or areas of a screen (e.g., Location field, Selected Licenses area of a screen).

**bold italic** Represents characters that you must type exactly as they appear in the instructions. For example, if you are instructed to type http://wtbwww01.fcc.gov, you should type all of the characters shown in bold italic exactly as they are printed.

**SMALL CAPS** Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).

*Note:* Throughout these instructions, “enter” means to type the appropriate information and then press the ENTER key.

A. Option 1: Tracking the Auction via the FCC Wide Area Network

The FCC has implemented a Remote Access System that allows users to dial in directly to the FCC to view round results, auction announcements, and messages, and to make suggestions to the FCC regarding the FCC auction process.

1. Minimum Hardware and Software Requirements

The following minimum hardware and software is required to use the FCC Remote Access System:

a. Hardware Requirements

- CPU: Intel Pentium
b. Software Requirements

- Operating System: Microsoft Windows 95/98
- Point-to-Point Protocol (PPP) Dialer: Use the Dial-Up Networking feature included with Windows 95/98
- Web Browser: Netscape® Communicator™ 4.73 is recommended. However, you can also use Netscape Communicator 4.5, 4.51, 4.61, 4.7, or 4.72 (Internet web browser software).

Note: To download Netscape Communicator 4.73 free of charge, access the Netscape download site at http://home.netscape.com/download/

2. Connecting to the FCC Network

To use the FCC Remote Access System, you must first connect to the FCC Network using Dial-Up Networking.

Dial-Up Networking connects to a 900 number telephone service at a charge of $2.30 per minute. The first minute of connection time to the 900 number service is at no charge.

Dial-Up Networking establishes a point-to-point connection from your PC to the FCC Network. *This point-to-point connection is not routed through the Internet.*

For instructions regarding how to connect to the FCC Network using Dial-Up Networking, see the *Accessing the FCC Network Using Windows 95/98* attachment.

For technical assistance with installing or using FCC software, contact the FCC Technical Support Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY). The FCC Technical Support Hotline is generally available Monday through Friday from 7 a.m. to 10 p.m. ET, Saturday from 8 a.m. to 7 p.m. ET, and Sunday from 12 p.m. to 6 p.m. ET. *All calls to the FCC Technical Support Hotline are recorded.*

3. Using the FCC Remote Access System

After you have connected to the FCC Network, start your Netscape Web browser. In your browser’s Location field, enter http://wtbwww03.fcc.gov and then click Round Results Viewer, Suggestion Box, or Announcements.

*Note:* If you cannot access the preceding site, and you suspect there is a problem with your Domain Name Server (DNS), refer to *Accessing FCC Sites In Case of DNS Problems* at the end of this document. Or you can use the alternate location, http://wtbwww26.fcc.gov.
When you have finished, exit your Web browser, then disconnect from the FCC Network.

**B. Option 2: Tracking the Auction via the Internet**

You may use your Web browser to download announcements and round results from [wtbwww01.fcc.gov](http://wtbwww01.fcc.gov) – or from either of two secondary locations, [wtbwww13.fcc.gov](http://wtbwww13.fcc.gov) or [www.fcc.gov/wtb/auctions/](http://www.fcc.gov/wtb/auctions/) -- as described in the following sections.

1. **Downloading from wtbwww01.fcc.gov or wtbwww13.fcc.gov:**

1. Connect to your Internet service provider and start your Web browser.

2. In the Location field of the Web browser screen, enter one of the following locations: http://wtbwww01.fcc.gov or wtbwww13.fcc.gov

   **Note:** If you cannot access either of the preceding sites, and you suspect there is a problem with your Domain Name Server (DNS), refer to Accessing FCC Sites In Case of DNS Problems at the end of this document.

3. Click **Auction 80**.

   - For auction announcements, click **Announcements**.
   - To download a bid import template file, click **Announcements**, then select **template.txt**.
   - For auction round results, click **Results** and then click the subdirectory for the type of files you want to use:

     - **mdb** - Microsoft Access database files in zipped form
     - **txt** - text files
     - **dbf** - dBASE database files

4. Click the file you want to download.

2. **Downloading from www.fcc.gov/wtb/auctions/**:

1. Connect to your Internet service provider and start your Web browser.

2. In the **Location** field of the Web browser screen, enter the following location: http://www.fcc.gov/wtb/auctions/

3. Do the following:

   a. In the **Auctions** section on the right, click **Blanco Texas Broadcast (#80)** under **In Progress**.
   b. Then click **Announcements, Programs, or Results**.
For auction announcements, click **Announcements**.

To download a bid import template file, click **Announcements**, then select **template.txt**.

For auction round results, click **Results** and then click the subdirectory for the type of files you want to use:

- **mdb** - Microsoft Access database files zipped
- **txt** - text files
- **dbf** - dBASE database files

4. Then click the file you want to download.

3. **Announcement Files**

The announcement files will use the naming convention *aa_xxx.nn*, where *aa* is the auction number, *xxx* is the round number and *nn* is the announcement number. For example, 80_002.07 would represent an announcement for Auction 80 that was posted during round two and was the seventh announcement for the auction.

4. **Round Results Files**

For each round, dBase-compatible database files will be uploaded with the following naming conventions (where *xxx* represents the round number):

- 80_xxxS.DBF contains all bids submitted in a particular round
- 80_xxxW.DBF contains all bids withdrawn in a particular round (withdrawals are not permitted in auction 80)
- 80_xxxE.DBF contains the maximum eligibility and remaining number of waivers for each bidder
- 80_xxxH.DBF contains the high bid in a particular round and the minimum accepted bid for the next round

For those who cannot use the dBase-compatible database files, we will also upload the ASCII text (.TXT) version of these files with the same filenames as above (e.g., 80_xxxS.TXT, 80_xxxE.TXT).

In addition, if you want to use Microsoft Access, we upload the MDB access version of the round results files as a zipped file with a name of the form 80_xxx.ZIP.

**File Formats:** For a description of the internal formats of the round results files, refer to **Round Results File Formats** at the end of this document.

a. **Locations of Uploaded Files**

The newest round results are uploaded to the **Results** directory based on type of file format: dbf, mdb (zip files), and txt.

**On the primary location, wtbwww01.fcc.gov:**
b. Archive Directories

After every 50 rounds, files will be moved from the Results directory to archive directories. The following listings show an example of the directory structure for an auction in round 102. Note that the results for rounds 101 and 102 would be in the Results directories.

On the primary location, wtbwww01.fcc.gov:

<table>
<thead>
<tr>
<th>Rounds</th>
<th>Directory Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-50</td>
<td><a href="http://wtbwww01.fcc.gov/MBB/CP5/Auction_80/Results/dbf/D001_050">http://wtbwww01.fcc.gov/MBB/CP5/Auction_80/Results/dbf/D001_050</a></td>
</tr>
<tr>
<td>51-100</td>
<td><a href="http://wtbwww01.fcc.gov/MBB/CP5/Auction_80/Results/dbf/D051_100">http://wtbwww01.fcc.gov/MBB/CP5/Auction_80/Results/dbf/D051_100</a></td>
</tr>
<tr>
<td>101-102</td>
<td><a href="http://wtbwww01.fcc.gov/MBB/CP5/Auction_80/Results/dbf/">http://wtbwww01.fcc.gov/MBB/CP5/Auction_80/Results/dbf/</a></td>
</tr>
<tr>
<td>1-50</td>
<td><a href="http://wtbwww01.fcc.gov/MBB/CP5/Auction_80/Results/mdb/M001_050">http://wtbwww01.fcc.gov/MBB/CP5/Auction_80/Results/mdb/M001_050</a></td>
</tr>
<tr>
<td>51-100</td>
<td><a href="http://wtbwww01.fcc.gov/MBB/CP5/Auction_80/Results/mdb/M051_100">http://wtbwww01.fcc.gov/MBB/CP5/Auction_80/Results/mdb/M051_100</a></td>
</tr>
<tr>
<td>101-102</td>
<td><a href="http://wtbwww01.fcc.gov/MBB/CP5/Auction_80/Results/mdb/">http://wtbwww01.fcc.gov/MBB/CP5/Auction_80/Results/mdb/</a></td>
</tr>
<tr>
<td>1-50</td>
<td><a href="http://wtbwww01.fcc.gov/MBB/CP5/Auction_80/Results/txt/T001_050">http://wtbwww01.fcc.gov/MBB/CP5/Auction_80/Results/txt/T001_050</a></td>
</tr>
<tr>
<td>51-100</td>
<td><a href="http://wtbwww01.fcc.gov/MBB/CP5/Auction_80/Results/txt/T051_100">http://wtbwww01.fcc.gov/MBB/CP5/Auction_80/Results/txt/T051_100</a></td>
</tr>
<tr>
<td>101-102</td>
<td><a href="http://wtbwww01.fcc.gov/MBB/CP5/Auction_80/Results/txt/">http://wtbwww01.fcc.gov/MBB/CP5/Auction_80/Results/txt/</a></td>
</tr>
</tbody>
</table>

If you cannot access the files at the preceding primary location, you can access the same files at either of the following secondary locations: wtbwww13.fcc.gov or www.fcc.gov/wtb/auctions/.

C. Option 3: Tracking the Auction via the FCC’s Automated Round Results System

Round results are also available from a touch-tone phone, using the FCC’s Automated Round Results System. To access this system, dial 800-432-2110 from outside the Washington DC area and 202-414-1260 from within the Washington DC area. Once the system has been activated, you will follow the voice prompts. You will need to know the auction number (80, in this case) and the round number.

D. Accessing FCC Sites In Case of DNS Problems

When you enter a URL into your browser, the system must convert this alphanumeric text (e.g., www.fcc.gov/wtb/auctions/) into its associated numeric IP address (192.104.54.3, in this case). To make this conversion, the system checks URL-to-IP-address “lookup” tables in two different places.

First, it looks at the table contained in a file called hosts in the c:\windows directory on your computer’s hard drive. If the URL is not in that table, the system looks in the database on your Domain Name Server (DNS). However, if your DNS is unavailable for some reason, the system will not be able to find the IP address you requested.
The following procedure is intended to help ensure that you can access auction results files on the FCC’s Web and FTP sites if your designated DNS has problems. Note the following:

- The IP addresses shown in the following procedure are correct as of the date this document was created. They may have changed subsequently. In case of problems, please check with Tech Support at (202) 414-1250.

- Make entries in the hosts file only to work around DNS problems. We do not recommend leaving these entries in permanently; please remove them when your DNS problem has been resolved.

To add FCC-related URL entries to your computer’s hosts file, do the following:

1. Using Windows Explorer, ensure that the hosts file exists in your c:\windows directory. If c:\windows has no hosts file, use the Windows Rename function to change the name of the hosts.sam file to hosts (with no extension).

   To do this, use your right-hand mouse button to click the hosts.sam file, then click the Rename option in the menu that appears.

2. Using a text editor of your choice, such as Wordpad or Notepad, open the hosts file in your c:\windows directory.

   This file will already contain the following entry:

   127.0.0.1 localhost

3. Using the same format (with at least one space between each number and its corresponding URL), add the following entries to the bottom of the file:

   192.104.54.3 ftp.fcc.gov
   192.104.54.3 www.fcc.gov
   208.245.40.194 wtbftp02.fcc.gov
   208.245.40.194 wtbwww01.fcc.gov
   207.123.193.68 wtbftp01.fcc.gov
   207.123.193.68 wtbwww01.fcc.gov

4. Save the file and exit your text editor.

Be sure that the file name has not changed to hosts.txt or hosts.doc or similar. It must remain just hosts (with no extension).

E. Round Results File Formats

This section describes the formats for the round results files that will be uploaded to the FCC Internet site after each round of the auction. These files are in dbf and txt format and contain the raw output of the auction data.
The round results files were used by the previous Excel based tracking tool produced by the FCC and are still being distributed for those bidders who use them for their own tracking purposes. The following layouts are for the dbf files. The txt files will have character field types.

### 1. ALL_BIDS file

- **mx_group**: char(6)
- **freq_block**: char(2)
- **round_num**: numeric
- **bid_amt**: numeric
- **bidder_num**: numeric
- **fcc_acct**: char(10)
- **date**: char(10)
- **time**: char(14)
- **net_bid_amt**: numeric
- **sort_col_1**: numeric
- **sort_col_2**: numeric
- **sub_market**: numeric

### 2. HIGH_BIDS file

- **mx_group**: char(6)
- **freq_block**: char(2)
- **bid_round**: numeric
- **bid_amt**: numeric
- **bidder_num**: numeric
- **fcc_acct**: char(10)
- **date**: char(10)
- **time**: char(14)
- **net_bid_amt**: numeric
- **min_accept**: numeric
- **num_of_bids**: numeric
- **sort_col_1**: numeric
- **sort_col_2**: numeric
- **sub_market**: numeric

### 3. MAXIMUM_ELIGIBILITY file

- **round_num**: numeric
- **bidder_num**: numeric
- **fcc_acct**: char(10)
- **max_elig**: numeric
- **rmng_waivr**: numeric
- **waivr_ind**: char(1)
- **rmng_withdrawals**: numeric
- **required_act**: numeric
- **current_activity**: numeric
4. **WITHDRAWALS file**

- `mx_group` char(6)
- `freq_block` char(2)
- `bid_round` numeric
- `bid_amt` numeric
- `bidder_num` numeric
- `fcc_acct` char(10)
- `date` char(10)
- `time` char(14)
- `net_bid_amt` numeric
- `sort_col_1` numeric
- `sort_col_2` numeric
- `sub_market` numeric

5. **BIDDER_CROSS_REFERENCE file**

- `bidder_num` numeric
- `fcc_acct` char(10)
- `co_name` char(50)
- `bidding_credit_pctg` numeric
- `short_name` char(10)
- `bidder_num` numeric

**F. Help**

For technical assistance with installing or using FCC software, contact the FCC Technical Support Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY). The FCC Technical Support Hotline is generally available Monday through Friday from 7 a.m. to 10 p.m. ET, Saturday from 8 a.m. to 7 p.m. ET, and Sunday from 12 p.m. to 6 p.m. ET. *All calls to the FCC Technical Support Hotline are recorded.*
I. ATTACHMENT E

ACCESSING THE FCC NETWORK USING WINDOWS 95/98

This attachment describes how to access the FCC Network from a system that is running the Microsoft Windows 95 or Microsoft Windows 98 operating system. This involves configuring dial-up network access and then performing the dial-up procedure.

This attachment describes two methods to establish a remote connection to the FCC Network for both the Mock Auction and Auction 80:

- The section titled Quick-Start Method for Connecting to the FCC Network describes a quick-start approach, which uses standard default values to configure the dial-up networking software.

- If you need something other than the standard defaults, you can use the more complete method for configuring and starting the dial-up software that is described under Complete Method for Connecting to the FCC Network.

This attachment also provides sections describing Troubleshooting and Help.

Conventions

The instructions in this section use the following typographical conventions:

**bold** Represents objects on the screen that you click with the mouse pointer, including buttons, Internet links, icons, tabs, menu items (e.g., Cancel button, Auctions link, Save option in the File menu).

*italic* Represents field names or areas of a screen (e.g., Applicant field, Selected Licenses area of a screen).

**bold italic** Represents characters that you must type exactly as they appear in the instructions. For example, if you are instructed to type http://wtbwww03.fcc.gov, you should type all of the characters shown in bold italic exactly as they are printed.

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).

**Note:** Throughout these instructions, “enter” means to type the appropriate information and then press the ENTER key.
A. Quick-Start Method for Connecting to the FCC Network

Following are quick-start procedures to establish a remote connection to the FCC Network for both the Mock Auction and Auction 80.

**Important:** Disable any screen saver software before performing either of the following procedures.

1. Quick-Start for Mock Auction

To establish a remote connection to the FCC Network, double-click the **Mock 80 Dial-Up Connection** icon and then select **Connect**. Alternatively, you may do the following:

1. Click the Windows 95/98 **Start** button.
2. Click the **Programs** option.
3. On the Programs menu, click the **FCC Remote Bidding Software** option.
4. Click **Mock 80 Dial-Up Connection**.

The system checks to ensure that your computer has all components necessary to establish a dial-up connection. If a required component is missing, the system invokes Windows to help you set up the component.

5. When the system has verified that all necessary components are present, a dialog appears with instructions on how to establish the dial-up connection. Read these instructions, then click the **OK** button.

6. When the dial-up connection window appears, click **Connect** to connect to the FCC Network.

Note that the system has also placed an icon labeled **Mock 80 Dial-Up Connection** on your desktop. To establish a dial-up connection in the future, you can double-click this icon instead of performing the preceding steps.

2. Quick-Start for FCC Auction 80

**Note:** If you connect to the FCC’s 900# telephone service, there is a charge of $2.30 per minute. The first minute of connection time to the 900 number service is at no charge.

To establish a remote connection to the FCC Network, double-click the **Auction 80 Dial-Up Connection** icon and then select **Connect**. Alternatively, you may do the following:

1. Click the Windows 95/98 **Start** button.
2. Click the **Programs** option.
3. On the Programs menu, click the **FCC Remote Bidding Software** option.

4. Click **Auction 80 Dial-Up Connection**.

   The system checks to ensure that your computer has all components necessary to establish a dial-up connection. If a required component is missing, the system invokes Windows to help you set up the component.

5. When the system has verified that all necessary components are present, a dialog appears with instructions on how to establish the dial-up connection. Read these instructions, then click the **OK** button.

6. When the dial-up connection window appears, click **Connect** to connect to the FCC Network.

   Note that the system has also placed an icon labeled **Auction 80 Dial-Up Connection** on your desktop. To establish a dial-up connection in the future, you can double-click this icon instead of performing the preceding steps.

3. **If You Have Trouble Establishing the Connection**

   If you are have trouble making the connection, two things may have to be changed:

   - The connection automatically precedes the phone number that is to be dialed with 9. If you need a digit other than 9 to reach an outside line, or no digit is needed, you will need to change the settings in the connection.

     To make this change, double-click the connection icon, then click **Dial Properties**. You will see that 9 precedes the phone numbers on all calls, both local and long-distance. Change this digit to what you need to get an outside line, or delete the 9, if appropriate. Then click **OK**.

   - The connection is set up for a standard 56K modem. If you are using some other kind of modem, you must change this setting.

   To access dial-up networking:

   1. Click the Windows 95/98 **Start** button.

   2. Click the **Programs** option.

   3. On the Programs menu, click the **Accessories** option.

   4. In Windows 95, click **Dial-Up Networking**. In Windows 98, click **Communications**, then **Dial-Up Networking**.
5. When you see the icon for dial-up networking that was created for you, right-click it and select **Properties**.

You will be in the General tab and you will see the standard default modem selected.

6. Select your modem from the drop-down menu and then click **OK**.

**B. Complete Method for Connecting to the FCC Network**

This section describes how to configure both the FCC Mock Bidding Software and the FCC Remote Bidding Software for dial-up networking. Then it describes how to use the configured software to establish a connection to the FCC Network.

1. **Configuring Dial-Up Networking**

   **Important:** Disable any screen saver software before performing the following procedure.

   1. To start dial-up networking:

      a. Click the Windows 95/98 **Start** button.
      b. Click the **Programs** option to display the Programs menu.
      c. Click the **Accessories** option to display the Accessories menu.
      d. In Windows 95, click **Dial-Up Networking**.
         In Windows 98, click **Communications**, then **Dial-Up Networking**.

      If Dial-Up Networking is not an option on your Accessories menu, you should install it from your Windows 95/98 CD or diskettes.

   2. When the Dial-Up Networking window appears, double-click the **Make New Connection** icon.

      The Make New Connection window appears.

   3. If you are connecting to the FCC Network during the Mock Auction, type **FCC Auctions 800#** in the field titled **Type a name for the computer you are dialing**.

      If you are connecting to test your connection on the 900# that will be used during Auction 80, type **FCC Auctions 900#** in the field titled **Type a name for the computer you are dialing**.

      **Note:** If you connect to the FCC’s 900# telephone service, there is a charge of $2.30 per minute. The first minute of connection time to the 900 number service is at no charge.

   4. In Windows 95, click the down arrow at the right of the **Select a modem** field and select your modem from the menu of available modems.
In Windows 98, click the down arrow at the right of the Select a device field and select your modem from the menu of available devices.

If your modem does not appear on this list, you must install your modem driver according to the modem manufacturer installation procedures, which are usually described in your modem’s user manual.

5. Click the Next button.

6. If you are connecting to the FCC Network during the Mock Auction, type 800 and 378-7435 in the Area Code and Telephone Number fields, respectively.

   If you wish to test your connection on the 900# that will be used during Auction 80, type 900 and 555-5335 in the Area Code and Telephone Number fields, respectively.

7. Verify that the correct country is selected in the Country code field.

   If necessary, click the down arrow at the right of the Country code field and select the appropriate country from the menu of available countries.

8. Click the Next button.

9. Click the Finish button.

   An icon labeled either FCC Auctions 800# or FCC Auctions 900# appears in the Dial-Up Networking window.

10. Verify that properties are configured correctly before attempting a dial-up session. Put the mouse pointer on the FCC Auctions icon that you wish to configure and click the right mouse button to display a menu. Click Properties from the menu.

11. Click the Configure button. Click the Options tab at the top of the Properties window.

12. In the Connection control area of the Options tab, verify that neither option is selected. If either option is selected, click the check box at the left of the option to deselect it. Then click OK.

13. In Windows 95, click the Server Type... button.

   In Windows 98, click the Server Types tab at the top of the Properties window.

14. In the Advanced Options area, verify that only Enable software compression is selected.

   If it is not selected, click the check box at the left of the option to select it. If either of the other options is selected, click the check box to deselect it.
15. In the Allowed Network Protocols area, verify that only TCP/IP is selected.
   If it is not selected, click the check box at the left of the option to select it. If either of the other options is selected, click the check box to deselect it.

16. Click the TCP/IP Settings button and select Specify name server addresses.

17. Type **165.135.241.149** as the Primary DNS and **165.135.79.95** as the Secondary DNS.

18. At the bottom of the TCP/IP Settings window, ensure that Use IP Header Compression and Use Default Gateway on the Remote Network options are selected.

19. Click OK on the TCP/IP Settings window and the Server Type window.

20. a. Click the Windows 95/98 Start button, then click the Settings option to display the Settings menu.

   b. Click Control Panel and then double-click the Network icon.

   c. Highlight the TCP/IP Protocol and click Properties. If there are multiple TCP/IP protocols, highlight TCP/IP --> Dial-Up Adapter and click Properties.

   d. Click the DNS Configuration tab.

   e. Type bidder in the Host box and type fcc.gov in the Domain box.

      **Note:** You are limited to three DNS entries. If you already have three DNS entries, you must delete two of them before performing the next two steps. To do this, click the first entry you want to delete and click the Remove button. Then click the second entry you want to delete and click the Remove button again.

   f. Type **165.135.241.149** in the DNS Server Search Order box and click the Add button.

   g. Type **165.135.79.95** in the DNS Server Search Order box and click Add again.

   h. Click OK on the TCP/IP Properties windows, then click OK on the Network windows.

   If you are prompted to restart your computer, click Yes to restart, then begin the Dial-Up Procedure.

2. **Dial-Up Procedure**

1. If the Dial-Up Networking window is not currently open, do the following:

   a. Click the Windows 95/98 Start button.
b. Click the Programs option to display the Programs menu.

c. Click the Accessories option to display the Accessories menu.

d. In Windows 95, click Dial-Up Networking
   In Windows 98, click Communications, then Dial-Up Networking.

The Dial-Up Networking window appears.

2. In the Dial-Up Networking window:

   Double-click the FCC Auctions 800# icon if you wish to connect to the FCC Network during the Mock Auction.

   Double-click on the FCC Auctions 900# icon if you wish to test your connection to the 900# that will be used during Auction 80.

   Note: If you connect to the FCC’s 900 number telephone service, there is a charge of $2.30 per minute. The first minute of connection time to the 900 number service is at no charge.

3. Click the Connect button on the window. Do not enter User name or Password.

   The Connection window appears, indicating the status of your connection as your modem dials into the system. This window must remain running during your dial-up session. You may minimize the window, if you wish.

   If your modem fails to establish a connection, please see the Troubleshooting section below.

4. Once the connection is established, double-click the Auction 80 Mock Auction Software or Auction 80 Bidding Software icon.

5. When you have finished, exit the mock or auction software, then click the Disconnect button on the Connection window to end your dial-up session.

C. Removing the Dial-Up Networking Service

Once you have finished using the dial-up networking service, you can remove it from your computer, as follows:

1. Click the Windows 95/98 Start button, then click the Settings option to display the Settings menu.

2. Click Control Panel and then double-click the Network icon.

3. Highlight the TCP/IP Protocol and click Properties. If there are multiple TCP/IP protocols, highlight TCP/IP --> Dial-Up Adapter and click Properties.

   In a Windows 98 environment, a confirmation dialog appears. Read the information on the dialog, then click the OK button.
4. Click the **DNS Configuration** tab.

5. Click the DNS Server Search Order box containing **165.135.241.149** to select it, then click the **Remove** button.

6. Similarly, click the DNS Server Search Order box containing **165.135.79.95** to select it, then click the **Remove** button.

7. Click **OK** on the TCP/IP Properties windows, then click **OK** on the Network windows.

8. If you are prompted to restart your computer, click **Yes** to restart.

9. Remove the **FCC Auctions 800#** icon from your desktop. That is, click the icon with your **right** mouse button and then click the **Delete** option in the pull-down menu.

**D. Troubleshooting**

Following are problems you may encounter and possible solutions for resolving or isolating them.

1. **Modem does not respond**

   1. Confirm that all physical connections for the modem are present.
   
   2. Confirm that the phone line is active by connecting it to a telephone and checking for a dial tone.
   
   3. If you are dialing the 900 number service, check for a 900 number telephone block. If the volume settings are low, the modem may be dialing but not connecting. Check for this by trying to connect to the 800 number, or by dialing the 900 number on that line using a telephone.
   
   4. Confirm that the correct modem driver is installed for your modem.

2. **Modem dials but does not connect**

   1. If you are dialing the 900 number service, check for a 900 number telephone block. Check for this by dialing the 800 number to see if you connect, or by dialing the 900 number on that line using a telephone.

   2. Confirm that the number the modem is dialing is correct.

   3. Confirm that the modem prefix, if any, is correct.
3. **Modem dials and connects, but nothing appears when you enter the Location in the Web browser**

1. Verify the Dial-Up Networking settings specified in the *Configuring Dial-Up Networking* section.

2. Confirm that your Web browser is not using proxies.

   a) On your browser, click the **Preferences** option in the Edit menu.
   
   b) In the Category area at the left, double-click **Advanced**.
   
   c) Click the Advanced structure’s **Proxies** option.
   
   d) Click the radio button labeled **Direct connection to the Internet**.
   
   e) Click the **OK** button at the bottom of the window.

4. **Receive an Internal Server error in the Web browser**

1. Confirm that the *Location* is correct.

2. Confirm that *Java* and *JavaScript* are enabled in your Web browser, and confirm that *Cookies* is set to *Accept All*.

**E. Help**

For technical assistance with installing or using FCC software, contact the FCC Technical Support Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY). The FCC Technical Support Hotline is generally available Monday through Friday from 7 a.m. to 10 p.m. ET, Saturday from 8 a.m. to 7 p.m. ET, and Sunday from 12 p.m. to 6 p.m. ET. *All calls to the FCC Technical Support Hotline are recorded.*